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Introduction Console Operator Quick Reference Guide
Introduction

NEC’s Console product provides operators with the ability to manage and redirect phone calls using one application. 
Console provides all the traditional call management tools in an intuitive Graphical User Interface (GUI) that help 
make an operator more productive. This guide provides step-by-step instructions on how to use the Console 
product.

Log In and Out of Console

Log into Console

1. On the PC’s Desktop, double-click the Console shortcut icon.

2. In the Login Name field, type your full name (your name may automatically display after typing a few letters).

3. In the PIN field, type the PIN number (initially the PIN is 2222 until you change it to a unique number.)

4. Optional: Click the Remember Me Next Time option to save this login information for the next time you start 
Console.

Log Out of Console

1. Log out of the queues (see ”Log Out of Queues” on page 18 for details).

2. Use any of the following methods to log out of Console:
• Click the Close button (the red X in the upper right-side of Console).
• From the File menu, select Exit.
• Press Alt + F4.
NEC Corporation of America ©2011 003NEC-00QRGR 1



The Console Interface Console Operator Quick Reference Guide
The Console Interface

The main Console window is divided into several windows that show current calls and call history.

Item Name Description

Toolbar and Menus Enables the operator to set the queue mode and breaks.

Default Action and 
Active Call window

Shows information about the current call, including the Caller ID, Phonebook 
information, and any previous handling. The Default Action is linked to the Enter 
key on the keyboard (see ”The Default Action Button” on page 3 and ”Active Calls 
Window” on page 4 for details).

Calls Waiting window Shows a list of unanswered and recalling calls, as well as dial operator calls from 
voicemail (see ”Calls Waiting Window” on page 5 for details).

Parked Calls window
Shows all calls currently parked at any extension. Separate lists show calls parked 
by operators and calls parked from phones or voicemail (see ”Parked Calls 
Window” on page 6 for details).

Destination window
Used to enter a name or number to call, or to transfer the current call to. Shows 
Phonebook information and the currently active Profile (for Voicemail users) (see 
”Destination Window” on page 6 for details).
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The Default Action Button

The Default Action button is the main button in Console. To quickly perform the most common actions for the current 
call or other activity (such as deliver, answer, or hang up a call), use the Default Action button by either clicking the 
button with the mouse or pressing Enter on the keyboard.

Additional Functions 
window

Provides tabbed functional windows with additional functionality:

• Presence functions/buttons to view extension status at a glance and route calls 
to the extension or voicemail.

• Call History to view recent call details.
• Message information to manage voicemail and fax messages for company 

mailboxes (needs to be configured before it displays).
• A Web browser.
• Quick Find to quickly see a list of phonebook entries matching a partial entry in 

the Destination field (has to be enabled in Preferences before it displays).
• Desk-to-desk Chat to respond textually to information requests from other 

users.

Speedbar Provides quick mouse access and keyboard/function shortcuts to available options 
for the current call (see ”Speedbar Functions” on page 7 for details).

Item Name Description
NEC Corporation of America ©2011 003NEC-00QRGR 3
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Active Calls Window

The Active Calls window shows information about the current connected call.

Item Description

Call type and connect time.

Caller's phone number and CLI information from the Phonebook, if available (such as a person's name and 
company name). 

Previous call handling, and any additional notes from the Phonebook or entered for this call with Ctrl+I.

Default Action, linked to the Enter key on the keyboard.

The Phone Status icon at the top-left of this window displays the status of the operator's phone at a glance:

No call—the operator's extension is currently idle. 

(Yellow) A queue-delivered call is currently ringing on the extension. The caller dialed the number for the 
company or another general number.

(Green) A non-queue call is currently ringing on the extension. The caller directly dialed the operator's 
telephone or extension number.

(Pink) The operator has dialed a number and is waiting for an answer.

(Yellow) A call is in progress that was delivered by the queue. 

(Green) A non-queue call is in progress. 

(Pink) An outbound call dialled by the operator is in progress.

The operator has parked this call using the personal park function at the extension (not the Console F6 
key Hold function).

Another party has put this call on hold.
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Calls Waiting Window

Calls Waiting calls have not yet been answered by the operator. View all waiting calls by scrolling though the list of 
calls.

Item Description

Number of calls waiting to be answered.

The time that the oldest call has been waiting in the queue

Call priority (shown as a colored dot) and indial identifier (number called), if any.

Caller information (CLI or phonebook details of the contact).

Call type, or reason the call is in the queue. Types include:
• Forward = Calls forwarded from unanswered, unavailable, or busy extensions (additional information is 

given in the Special Info field).

• Recall = Unanswered or held calls recalled to the operator.

• Consult: Calls in the process of being transferred internally to the operator (the transferring extension 
has not hung up).

• VM Transfer = The caller has selected a <transfer to operator> one-touch key from a mailbox (the 
Special Info field shows the mailbox name the caller has been transferred from).

• Assist = An internal user has dialled the operator queue (different to consult where the caller does not 
have anyone on hold pending transfer).

• Direct = Direct or new call that has not been previously handled by the system.

Additional information, such as the internal call source and any notes from the Phonebook.
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Parked Calls Window

The Parked Calls window shows all calls currently parked at any extensions. Separate lists show parked calls and 
transferred calls waiting for pickup. Double-click any parked call by to pick it up.

Destination Window

Use the Destination window to enter a name or number to call or transfer the current call to. The Destination field 
shows Phonebook information and the currently active presence profile (for voicemail users).

• The Destination list automatically selects the default number from the Phonebook. This list also displays other 
numbers for this contact.

• The Info/Notes field shows Phonebook information and the currently active profile (for voice messaging users).

Item Description

Number of calls parked, and the longest parked call.

Caller ID and type of parked call (a Person image displays for the calls, and a Globe image for other people’s 
calls).

Person the call is parked for (or park slot)

More info about the call, such as the person who parked it

Calls below the line have been transferred but not yet answered by the new party. 
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Speedbar Functions

Use the:

• Speedbar to perform the active call functions using either the mouse or keyboard. Use the View menu to select 
the preferred viewing format of the Speedbar functions (i.e., icons, icons and text, etc.). 

• Enter and Function keys (F1 through F12) to perform any of the active Speedbar functions. 
• Global Hot keys when Console is not active to perform some of the actions.

– Hot keys are active when Console is the active application.
– Use the Global Hot keys when Console is open, but not the active application. Enable the Global Hot keys in 

the File > Preferences > General menu. Use the Hot key simultaneously with the Windows (“WIN”) key on 
the keyboard.

Keyboard Shortcuts

The following table lists the Hot key functions within Console (N/A indicates there is no Hot key for the function).

Console Function Console 
Hot Key

Global 
Hot Key Function Description

Answer a Call F2 WIN + F2 Answers a ringing phone call.

Bring to Front N/A WIN + F12 Brings Console into the front of the window.

Deliver a Call F9 WIN + F9 Delivers the call at the top of the Calls Waiting queue (or the specific 
selected call) to the telephone, and then the call displays in the 
Incoming Call field.

Dial F4 N/A Dials the destination displaying in the Destination field.

(Destination) Cancel F11 N/A While transferring a call or toggling, disconnects the current party 
and then automatically connects to the held party.

Exit Alt + F4 N/A Closes Console (a standard Windows command to close the active 
application).

Hang Up a Call F3 WIN + F3 Hangs up a phone call.

Help F1 N/A Opens the Online Help window.

Park a Call F5 WIN + F5 Parks the call.

Unpark a Call F5 N/A Retrieves the parked call.

Hold a Call F6 WIN + F6 Places the call on hold.

Unhold a Call F6 WIN + F6 Unholds the call.

Add Notes to a Call Ctrl + I N/A Opens a window to enter text notes for a call. These notes are 
visible to other Console or Desktop users if they receive the call 
(either in the information/notes area, or in a tooltip for the call).

Log in/Log out Ctrl + L N/A Opens the Queue Login window. When logged into queues, this Hot 
key logs you out of the queues.

Make a Call F4 N/A Makes a call to a selected number.

Record/Stop Record 
a Conversation

F8 N/A Records the conversation in progress into the voicemail.

Swap Held a Call F10 N/A Puts the current party on hold, and then connects to another party 
on hold (while transferring a call or toggling two calls).

Transfer F4 N/A Holds the active call while dialing the number displaying in the 
Destination field.

Voice Messaging F7 N/A Calls Voice Messaging—transfers a ringing call or a current call from 
the phone to any mailbox.
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The Presence Tab

Presence Buttons

The following are two types of Presence buttons:

Presence Icons

External = Telephone numbers outside the office.

Internal = Extension numbers in the office. Use the Internal Presence buttons to:
• View the user’s extension status by viewing the icons and the status tooltip. 

• Perform advanced call functions for an extension by right-clicking the icon. A user’s 
name displays in yellow text if logged into queues as an agent.

Icon Description

Phone Call Types

(Gray) Extension is idle.

(Various colors) Extension is ringing or offering.

(Various colors) Extension is busy (on the phone).

Extension is forwarded to another number (internal or external).

Forwarded to voicemail.

(Green) Inbound non-queue call.

(Pink) Outbound non-queue call.

(Yellow) Inbound queue call (if queuing is installed).

(Blue) Outbound queue call (if queuing is installed).

Profiles

In the office.

In a meeting.

Out of the office.

On vacation.

(Gray Head) Agent is logged into the queues.

Voicemail Status

No messages.

One or more standard messages.

One or more urgent messages.
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Additional Functions Using the Presence Buttons

Display Additional Contact Numbers

1. In the Active Calls window, click the Phone Status icon to display additional contact numbers.

2. From the menu, select the number to call.

Right-Click a Presence Button for Additional Menu Actions

 Right-click a Presence button, and then select the preferred action from the menu.

Note: The actual options available depend on the type of PBX being used, how the system is set up, 
and the enabled security permissions. Certain options are also only visible when there is an active call 
on the extension.

Icon Name Description

Call User on Extension Initiates a call to the user on the designated telephone number.

Supervised Transfer to User Transfers the Active Call to the user’s extension, and talk to the user 
before completing the transfer.

Blind Transfer to User Transfers the active call to the user’s extension.

Transfer Call Transfers the active call to the user’s extension.

Park for User Holds the active call at the user’s extension; the user can then retrieve 
the call.

Advanced Park Parks the active call and pages the user.

Notify Me when User is Back A ScreenPop informs when the user is in the office and available to 
take the call.

Forward All Calls Forwards all calls to a specified internal or external number.

Leave a Voice Message Record a voice message for the recipient.

Transfer to Mailbox Transfers the active call to the user’s voicemail.

Ask User to Call Me Back The user receives a ScreenPop callback request upon return.

Record Conversation to 
Mailbox

The conversation saves to the current user’s mailbox (if installed).

Send Message to Digital Phone Sends a short text message to the LCD screen of the user’s digital 
phone.

Select Presence Profile Changes the user’s Presence profile.

Rename Renames the Presence button. 

Delete Deletes the Presence button.

View As Changes the Presence buttons’ appearance.
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Set an Estimated Time of Return (ETR)

An Estimated Time of Return (ETR) can be set for the Presence profiles used when you are not available.

1. Select a profile, and then click the calendar function.

2. Select the date of return.

3. Select the approximate time of return using the standard times in the left window, or by setting the time using the 
clock field’s up and down arrows.

4. Click OK to save the ETR and activate the selected Presence Profile.

Add a New Presence Page

Use the Add Presence Page wizard to create either Standard or Dynamic Presence pages:

• Dynamic = Automatically lists the contacts for a company or department.
• Standard = Manually add and arrange the contacts.

1. Use either of the following methods to start the Add Presence Page wizard:
• From the File menu, select Add a New Presence Page.
• Right-click in the Presence window, and then select Add a New Presence Page.

2. Click Create Personal Presence Page (only administrators can create global pages), and then click Next.

3. Select the type of page to be created. Click either:
• Standard Page to manually add and arrange Presence buttons. If chosen, proceed to the next step.
• Automatic Page = Automatically adds and updates Presence buttons for the selected company/

department. If chosen, complete the following substeps.

a. Select a company from the listed companies, and then click Next.
b. Optional: Select List Only Contacts for the Selected Departments, and then click Next.

c. Click the department(s) to display if the department option was selected in the previous step, and then 
click Next.

d. Optional: Click the Create Additional Pages option, enter the number of buttons per page, and then 
click Next.This option defines a maximum number of Presence buttons per page and automatically 
creates an additional page when this maximum is reached.

4. Type a name for the Presence page, and then click Next.

Note: Unless the ETR is set as mandatory in the system settings, an ETR can be skipped by clicking the 
Skip ETR button.

Note: Only users with System Administrator rights can add or edit Global Presence pages.

Note: This step only displays if departments have been defined.
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5. Verify the settings and click Finish to create the Presence Page.

Rename a Presence Page

1. Use either of the following methods to rename a Presence page:
• From the File menu, select Rename this Page.
• Right-click in the Presence page, and then select Rename this Page.

2. Type the new name for the page, and then click OK.

Delete a Presence Page

1. Open the page to delete.

2. Right-click in any blank area, and then select Delete this Page.

3. When prompted to confirm the deletion, click Yes.

Add a Presence Button

1. Right-click in the Presence page, and then select Add a Presence Button.

2. Select either the contact name or the contact number (or drag a contact name or number from the Phonebook to 
the Presence page), and then click OK.

Delete a Presence Button

 Right-click a Presence button, and then select Delete.

Set a Presence Profile

1. Use either of the following methods to select and set a Presence Profile:
• Click the Presence Profiles tab of a user’s mailbox settings.
• Right-click a Presence button.

2. Select the preferred setting.
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The Call History Tab

The Call History tab displays a running history of calls made or received from Console. The Recent Calls listing 
automatically clears whenever Console is shut down.

The Call History indicates the:

• Call direction (e.g., incoming, outgoing, incoming queue calls)
• ID of incoming calls (CLI)
• Date of call
• Time commenced
• Call duration

The exclamation mark icon indicates a missed call. 

Delete a Call

 Right-click the call record to delete, and then select Delete Calls. To:

• Select multiple call records, press and hold CTRL and then left-click each call.
• Select all calls, press CTRL+A.
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The Messages Tab

The Messages tab enables the operator to view and manage fax and voicemail messages and mailbox settings for 
their own personal mailbox and selected company mailboxes.

The Web Browser Tab

Console includes a simple web browser, which allows sending and receiving URLs within desk-to-desk chat calls 
with other users (running Console or Desktop). Most of the basic settings of the browser come from the Internet 
Explorer settings of the Windows user and workstation. 

Note: The Messages tab must be configured and is not available by default.

Item Description

View your personal mailbox and any system mailboxes. Edit the properties of the selected mailbox by 
clicking the Mailbox Properties icon.

Messages in the selected mailbox are shown in the main window.

• Double-click the message to open it.
• Right-click a message to either delete it or mark it as unread or saved.
Mailboxes on the system are shown in the right window. Personal mailboxes are shown with a Person icon, 
and company mailboxes are shown with a World icon. To move a message, drag the message from the main 
window to a mailbox in the right window.

When opening a voice message, the properties display (to open, right-click and select Play Message).

Play the message through the PC speaker or phone.

Click Save to save the message to a .wav file on the PC. Play the .wav file using Windows Media Player or 
other multimedia applications.
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The Quick Find Tab

Quick Find enables searching and selecting and dialing contacts based on a partial entry in the Destination field. The 
search results are limited to a maximum of 10 matching entries. 

 Click the Quick Find tab.

Note: If the Quick Find tab is not present, enable it from the General tab in Preferences.

Item Description

Type the first few letters of the party's name in the Destination field, and then Quick Find provides a list of 
matching names.

The Quick Find results show up to 10 matching names, with phone status, profile, and special information. 
Selecting an entry places it in the Destination field.
Use Hot keys:
• Ctrl+1 through Ctrl+10 to select an entry in the list. 

• Ctrl+Shift+1 through Ctrl+Shift+10 to dial an entry in the list.

Note: Use the main keyboard for Ctrl+Shift functions (the number pad does not allow these functions).

Right-click a contact for additional options, such as to:

• Call the extension
• Leave a voicemail message
• Record into the mailbox
• Send a message to the digital phone display
• Change the mailbox profile
• Create a speed-dial

On an active call, right-click to transfer, park, or place the call on hold. 

Note: Not all of these options are available for external contacts.

If a contact has more than one phone number, click the Phone icon to see a list of numbers.

The profile displays for internal contacts with mailbox profiles.Click the profile to select a different profile for 
the user.
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The Chat Tab

The Chat function enables desk-to-desk text chat between site users, and is a good way of exchanging information in 
real-time and saving a transcript record. While browsing, a website URL or the sequence of URLs can be 
automatically sent to the other chat participants. More than one chat conversation can be open at a time.

 Click the Chat tab to open the Chat window.

Chat Buttons

Button Description

Starts a new chat call to either a selected chat user or chat queue.

Ends the current chat call.

Transfers the current chat call to either a selected chat user or chat queue.

Invites one or more chat users to join the current chat call. Invitees must accept the invite to join.

Select the chat window, and then click the Copy button to copy the chat window to the clipboard.

Saves a transcript of the chat conversation in a text format to a specified disk directory.

Transmits the typed text. Alternatively, press the Enter key.

Closes the current chat window.

Adds, edits, or deletes standard chat phrases or commonly used URL links

A list of saved text phrase. When selected, the phrase is sent directly to the other chat parties.

A list of saved URLs. When selected, the URL is sent as a link directly to the other chat parties.
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Make a Chat Call

1. Click Initiate Chat to start a new chat call.

2. Click either Chat User or Chat Queue, and then select the specific entry from the list.

3. Click the Chat button in the window, and a new conversation window opens. 

4. In the message text field, type the message and then click Send Text (or press the Enter key) to transmit the 
typed text. An outbound chat call shows as waiting in the Active Calls window until the recipient answers the call.

End a Chat Call

1. Click End Conversation.

2. Optionally, click Save Conversation to save a transcript of the chat conversation in a text format to a specified 
disk directory.

3. Click the Close button to close the conversation window.

Answer a Chat Call

1. When a new chat call message displays, either click:
• Accept to answer the chat call, and then navigate to the Chat window by clicking the Chat tab. 
• Show Call to display the Chat window, and then click Accept.

2. In the message text field, type the reply message and then click Send Text (or press the Enter key) to transmit 
the typed text.

Transfer a Chat Call

1. Click Transfer to transfer the current chat call.

2. From the list, select a chat user or queue.

3. Optionally, click the Include Current Chat Conversation option to give the recipient access to the prior 
dialogue. 

4. Click Transfer to complete the call transfer.

Pushes the current Desktop browser URL to the chat recipients.

Automatically sends a series of web page URLs while navigating using the Desktop web 
browser—toggles this feature on and off.

Chat conversation—when pink, an outbound chat conversation.

Chat conversation—when green, an inbound chat conversation.

Button Description
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Chat Messages

The Chat Messages feature provides an organized listing of chat conversations and chat users. Select the required 
category and then use the right-click menu to access the available functions for the selected chat session or user. 

Basic Operator Tasks

Log into Queues

Before using Console to process calls, each operator must log into queues and select an operator class. The class 
settings determine which queues to answer calls from and how soon they are offered.

1. Use any of the following methods to log into the queues:
• Click the Login button.
• From the File menu, select Login.
• In the toolbar, click the Login icon.
• Press the Ctrl+L keys.

2. From the Class list, select the appropriate class and then click OK.

Help: For more details on Chat Messages and additional functions and configuration settings, refer to the 
online help.
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Log Out of Queues

 Use any of the following methods to log out of the queues:

• In the toolbar, click the Log Out of Queues icon.
• Press the Ctrl+L keys.

Breaks

Take a Break

While logged into a queue, you can request a break to indicate to the system that you are temporarily unavailable to 
receive queue calls.

1. In the toolbar, click either the Break:
• Icon to use the default Back in 5 Mins. No further action is needed.
• Down arrow to display a list of break reasons, and then proceed to the next step.

2. From the Break list, select either:
• A break reason and set the required break time.
• Custom to set up another reason that is not listed.

End a Break

 To be available and receive queue calls again when returning from a break, click the Break icon to cancel the 
current break.

Note: Remember to log out of any operator queues before closing the Console application.

Note: While on a break, you still receive inbound direct calls to your extension.

Note: Individual security permissions control which options can be set and used by the agent.

Note: If the agent is overdue from a break, the Break icon turns red.
NEC Corporation of America ©2011 003NEC-00QRGR 18



Call Functions Console Operator Quick Reference Guide
Call Functions

When callers ring a Console indial number, the call joins an operator queue. Calls from the operator queue(s) deliver 
to any free Console operators who are logged in to take calls.

Receive a Call

Console enables calls to be answered in several different ways. Operators can use different methods depending on 
the other tasks they are performing when a call arrives.

When a call comes into the operator’s queue, the call rings on the operator's extension (if calls are automatically 
delivered). Details of the caller display in the Active Call window.

Deliver a Call

When receiving an inbound operator queue call:

• The call rings on the operator's extension if automatic call delivery is set up. Details of the caller display in the 
Active Call window.

• If demand delivery is configured (non-automatic) or there are additional calls in the queue, the calls are shown in 
the Calls Waiting window.

Item Description

In the Calls Waiting window, select a call. The Default Action shows Deliver Call.

To deliver the call to your extension, perform one of the following:
• Click the Default Action button.

• Click the Deliver/F9 icon on the Speedbar.

• Press Enter.

• Press F9.
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Answer a Call

When a call has been delivered, it displays in the Active Call window.

Operators can also answer calls ringing on other extensions. The speed-dial functions can be found in the online 
help.

Transfer a Call

Transfer a Call Using the Destination Field

1. Make or answer a call

2. In the Destination field, type a name from the Phonebook. The field entry then auto-completes as the name is 
being typed.

3. Press Enter once to perform a supervised transfer.

4. Press Enter again to complete the transfer.

Item Description

An offering call displays in the Active Call window. The Default Action shows Answer Call.

To answer the call, perform one of the following:

• Click the Default Action button

• Click the Answer/F2 icon on the Speedbar.

• Press Enter.

• Press F2.

Note: If using a headset and Auto Answer is selected (File menu > Preferences > Telephone tab), the call 
automatically connects.

Note: You can also type a phone number directly into the Destination field to transfer to an outside 
phone number, or click a Presence button to pass a number into the Destination field.
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Transfer a Call Using the Presence Buttons

 Make or answer a call, and then see the following table for Presence transfer functions.

Item Description

On the Presence tab, right-click the Presence button of the person that to transfer the call to. 

Select one of the following options:

• Supervised Transfer to = Puts the original call on hold, and dials the second party. Click Complete 
Transfer to complete the transfer, connect the two parties, and disconnect yourself from the call.

• Blind Transfer to = Transfers the original call to the second party, and then disconnects you from the 
call. 
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Transfer a Call Using the Phonebook

Park a Call

Console allows parking a call for yourself or into another extension.

Park a Call for Yourself

 With a call is in the Active Call window, perform either of the following:

• Click the Park button on the Speedbar.
• Press F5.

The CLI and Console Operator extension display in the Parked Calls field (the longest parked call is automatically 
highlighted).

Item Description

To select the extension to transfer the call to, open the Phonebook and then double-click a name or number 
to call.  

Complete the following to search for a name.
1. In the Phonebook Search field, type a name. The Phonebook searches for and displays all the matches 

for the name.

2. From the results, select a name and then the required number.

To finalize the transfer, perform any of the following:

• Click the Complete Transfer button on the Speedbar. 

• Press F3.

• Press Enter.

The call connects to the transfer number.
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Retrieve a Parked Call

 Select a call in the Parked Calls window., and then perform either of the following:

• Click the Unpark button on the Speedbar.
• Press F5.

Park a Call for an Extension

 Right-click the Presence button that is to be used as the extension to park the call on, and then select Park for 
<name>. The CLI (caller) and Parked for name then display in the Parked Calls field.

Make a Call

 Make a call either using the Presence buttons, or by entering a name or number in the Destination field.

Find a Number

Find a Number Using the Presence Buttons

1. Locate the Presence button of the party to call.

2. If the party has:
• Only one number in the Phonebook, click the Presence button to make the call.
• More than one number in the Phonebook, click the Phone icon to see a list of alternate numbers and then 

select a number to make the call.

Find a Number Using the Destination field

1. In the Destination field, type the first few letters of the party's name.

2. If the name is found in the Phonebook, Console auto-completes the name in the field and shows the default 
number and any info/notes.

Note: The party’s Presence button also displays a blue border to facilitate location.
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• To see/choose other numbers, open the Destination field’s list, select a number, and then press Enter (or 
click the Default Action button) to make the call.

• You can also enter numbers in the Destination field, just as you would on a phone keypad. For external 
calls, enter any access codes (such as 1 for outside calls).

Console Administrative Features

This section describes the administrative functions that an operator can perform within Console—only if the operator 
has been granted the required security permissions via the Administrator application.

Operator Queue Modes

A mode is a set of parameters that control how and where calls deliver, and the announcements that play at different 
times of day. Modes can be scheduled, but the operator can manually override the mode.

Some modes are provided by default:

• Calls ring at the main Operator Console when the Day mode is active.
• When Night mode is active, calls may go to either a night bell or an after hours contact number, or play an after 

hours announcement with more contact information.
• When Unattended mode is active, calls may go to a backup operator.
• When Emergency mode is active, calls may go to either an announcement or a mobile phone.

View and Change Modes

Note: If Quick Find is enabled, you can quickly search through similar names.

Item Description

The toolbar includes a button for each available mode of the operator queue. The active mode is indicated 
with its button depressed.

If there is more than one operator, the operator can control the modes for each queue separately. Click:

• The mode’s list to see the modes for each queue. 

• A queue name to set that mode for that queue.
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Change User Profiles

Occasionally, operators change the Presence Profiles of others that display as in the office, when in reality they are 
traveling or out of the office.

1. Right-click the user’s Presence button.

2. From the resulting menu, select Select Presence Profile and then the correct profile from the list.

Manage the Messages

Operators have the ability to transfer voice messages from the Operator Console, most commonly when an operator 
is in charge of a company mailbox where they listen to messages left overnight and then route them to the necessary 
people. This feature must be enabled by the Administrator.

Item Description

Click the Messages tab.

Select the mailbox to view (you must have security rights).

View and/or listen to messages.

Drag and drop the messages into a queue or other person’s mailbox.
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Edit the Global Phonebook

The Phonebook in Console allows you to enter information about internal employees or external customers. Create or 
edit entries in the Global, company, or your own Personal Directory, which depends on the security rights.

The following can be input within the Phonebook:

• Phone, fax, pager numbers, etc.
• Email addresses
• Special information/notes (descriptive text about that person)
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Preferences

Preferences allow each operator to customize the view and behavior of Console. The available preference settings 
are grouped logically on different tabs of the window.
This section describes some of the common options that you can change from File menu > Preferences.

Feature Description

Use Global Hot Keys Enables the functionality provided by the Hot keys and keyboard shortcuts.

Using a Headset Choose Auto-Answer if using a headset to immediately connect to delivered calls without 
operator intervention.

Supervised Transfers Provides the option to either:
• Speak with the receiving party before transferring the call (i.e., Supervised or Executive 

transfer)
• Automatically transfer the call without speaking to the receiving party.

Use Quick Find Enables the Quick Find feature to search for and select contacts based on an entry in the 
Destination field.
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